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Live Picture Workshop 
Introduction

Understanding Live Picture

Live Picture is a unique resolution independent digital imaging program that allows the

seamless manipulation and editing of high resolution digital files in real time. It is also

the most ‘photographic’ of any digital editing application in terms of its effects and the

resulting ‘fine print’ luminosity of its images. 

First conceived of and coded by the French inventor Bruno Delean in the late 1980’s as a

method of placing on the new Macintosh desktop computers of that time, powerful image

editing capabilities that up until then had only been available on very expensive and ded-

icated hardware dependent workstations such as the Quantel Paint Box. When Live

Picture was first ‘announced’ at MacWorld in 1993 it featured a fully implemented 16 bit

workflow, independent and unlimited layers, and the ability to process in real time any

number of images of any size. At the same time Adobe Photoshop™ didn’t even possess

layers or a layer’s palette, let alone resolution independence or real time processing. Even

the simplest image editing tasks were extremely difficult to process in early versions of

Photoshop™, and expensive accelerated video cards were required in the most powerful

computers to efficiently process even relatively small Photoshop™ files. Overnight Live

Picture created a new standard in the editing of digital photographs, that today’s pixel

editing programs like Adobe Photoshop still do not even come close to matching. 

The main innovations in Live Picture that were not found (and in many cases are still not

available) in other programs such as Photoshop are:

Resolution Independence

All effects created in Live Picture, such as painting, filters, and masks, are resolution

independent. This means that they can be output at any size without resorting to inter-

polation of pixels. The effects are mathematically regenerated at the time of output dur-

ing FITS raster image processing (FITS RIP) at any specified resolution.

Layers

FITS layers can be reordered, deleted, resized, scaled, etc. Although other programs in the

early to mid 1990s had ‘layers’ or ‘objects’, they didn’t treat brush effects, such as paint-

ing, lighting, blurring, and color correction, as independent layers. The number of layers

in Live Picture is unlimited and doesn't depend on RAM memory.
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Understanding Live Picture

Selective Undo

Because of the FITS' technology mathematical approach, any effect in any layer can be

progressively modified or completely undone.

IVUE Technology

IVUE is unique in that it permits both fast viewing and geometric changes. With IVUE,

you can basically zoom into a 400MB image in just a few seconds. No special hardware

or extra memory is required. The other important aspect of IVUE technology is that Live

Picture can work directly on JPEG compressed images. It doesn't have to decompress the

entire image before using  it. Only the necessary pixels are decompressed. This greatly

facilitates the use of IVUE over networks, telecommunication lines, and on CD ROMS.

Brush Technology

In Live Picture, everything is done with brushes-not just painting, but image insertion,

ghosting, distortion, color changes, blur, sharpen, etc. The brush size is unlimited. For

example, you can sharpen a 400MB image with a single brush stroke. And the brush

operates in real time, i.e. its speed is independent of the underlying file size. 

Masking

Live Picture has semi-automatic silhouetting. It takes the previous background color and,

when the object is silhouetted, automatically calculates the difference between the previ-

ous and new backgrounds, and sets the edge using advanced ‘Chrominance

Compensation’ that virtually eliminates fringing and other selection artifacts.

Tragically Live Picture suffered the fact of many innovative and revolutionary applications

and was discontinued in March 1999. However while it was never recompiled to run

under OS X, it works perfectly in Classic mode. Indeed under Classic it is remarkably sta-

ble, even rivalling its legendary stability under Mac OS 8.1. Recently a special hacked ver-

sion of Live Picture has been made available which includes additional key board short

cuts and most importantly larger dialogue boxes that are better scaled to today’s massive

desktop monitor resolutions. Live Picture lives on!

Live Picture is also supported by a very active and inspiring Discussion Group (see bibli-

ography). These introductory notes are in part based on an interview with Bruno Delean

by E. Sapwater that was first published in Photo Electronic Imaging, Vol.37, No.4, 1994.
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Setting up Live Picture Involves

1. Setting up the Document Space

2. Setting up the General and ColorSync Preferences

Document Setup

Before creating a document for the first time go to ‘File/Document Setup’ to define the

document’s  background colour and resolution:

An initial view can also be setup to facilitate the design and page layout within a known

space. Checking the ‘Define Initial View’ box and setting the dimensions will automatically

generate the same initial view every time a new document is created. For example if your

output is always on an A4 sheet, it would make sense to begin with an initial A4 view.

However when working with single images it is

often unnecessary to define an initial view (or page

layout). Just ensure that ‘Auto View’ is checked ON

in the View Menu so that a new view is automati-

cally created exactly the same size as an inserted

image. In the case of a single image that doesn’t

need to be further cropped, this is often the only

view that will be required. Views simply facilitate

how we navigate and manage our image editing.
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Preferences

General Preferences
The Edit/Preferences/General settings dialogue box is relatively straight forward and is

well documented in the Live Picture manual. My basic settings are:

With ColorSync enabled, the View Menu

allows Display Matching where the image is

converted to the monitor’s profile before

being rendered to the screen, Soft Proofing

for evaluating the

image as printed, and

Gamut Warning to

highlight colours that

are outside of the

printer’s (destination)

gamut.

Live Picture uses the Mac OS ColorSync engine to manage the pro-

file transformations both on screen and in the Build dialogue box.

ColorSync Preferences
The Edit/Preferences/ColorSync settings dialogue box includes a Reference (or Source)

profile, a Monitor profile, and an Output (or Destination) profile.
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Setting Up Live Picture

Memory Management

Allocating System Memory
Irrespective of whether Live Picture is running under Mac OS 8, OS 9 or OS X Classic,

System Memory (RAM) needs to be allocated. Many functions in Live Picture operate very

efficiently with as little as 72 Mb RAM. However other functions such as Building Images

can be significantly improved with a higher RAM allocation.

OS 8 and OS 9
Click once on the Live Picture icon (in the Applications Folder) to highlight it - don't start

up Live Picture, just highlight its icon. Then go to ‘File > Get Info’ (Cmd + I) to open the

Information Dialogue where you can assign Memory to Live Picture:

OS X
Under OS X Classic you can still allocate memory to LP but not relative to the operating

system (as you can under OS 8 or 9). Set the Minimum Size to twice the Suggested Size

and set the Preferred Size to at least half of the total RAM memory that is installed on the

computer.  OS X’s dynamic memory management will then ensure trouble free operation.
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To determine the maximum ‘free’ RAM that can

be allocated to Live Picture, Click on the coloured

Apple icon in the top left corner of the screen

and select 'About this Computer' from the drop

down menu. This reveals how much memory the

System is using, and how much is 'Unused'. 

Multiply the amount of memory the System is

using by a factor of 3, and then subtract this

value from the ‘Largest Unused Block’ to deter-

mine the amount of memory to set as the

Preferred Size. This value is not absolute, how-

ever too little free memory may crash the System

Set the Minimum Size to twice the Suggested Size, and set the

Preferred Size to as much free memory as can be allocated. 
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Interface

Live Picture has a very simple interface across three distinct areas of the screen:

1: The MENU BAR is across the top of the screen. 

2: The TOOL BAR is on the left side of the screen. This can be toggled between two set-

tings; the creative tool bar and the positioning tool bar. Each contains numerous tools

and options. A view tool bar is also accessible from the View Menu on the MENU BAR.

Creative Tool Bar

Contains tools such as brushes, erasers, colour pickers etc.

Positioning Tool Bar 

Contains tools for moving, re-scaling, cropping, distortion etc of the image. 

View Tool Bar

Contains tools for creating and editing VIEWS (of how the image is

displayed on screen). 

3: The LAYER STACK is on the right side of the screen. A Live Picture 

image is made up entirely of layers. There are nine different Layer 

Types. There is no limit to the number or order of layers. 
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File Formats: IVUE and FITS

1: IVUE: This is Live Picture’s own file format. You have to initially convert all other file

formats to IVUE to use that file (image) in Live Picture. 

2: FITS: This is the file format in which your changes (image manipulations) are saved.  

3: OUTPUT: Your images can be output (built out) to any standard file format such as 

TIFF, EPS, Photoshop, etc.

Converting files to the IVUE format

In order to work with an image in Live Picture it must first  be converted into Live Picture’s

propriety IVUE file format.

1. Retouch the image in a pixel editing program (like Photoshop) and save as an 8 bit per

channel uncompressed TIFF file.

2. Open the TIFF file in Live Picture’s Menu Bar/Converter Menu.

3. Save As as an IVUE file.

4. Create a New Document (Cmd N) from the Menu Bar/File Menu.

5. Create an Image Insertion Layer (Cmd 4) from the Menu bar/Create Menu.

Alternatively in Mac OS 9 the file can be exported directly from Photoshop using Live

Picture’s IVUE Export plug-in. Make sure the plug-in is installed in Photoshop’s

Import/Export plug-in folder. IVUE files can also be imported directly into Photoshop via

this plug-in for pixel based editing, including the application of Photoshop filters. 

Note: While Live Picture has excellent Image Cloning capabilities, it is preferable to ini-

tially ‘spot’ the image in a pixel editing program like Photoshop which (unlike Live Picture)

will permanently render such changes in the image.
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Positioning Tools

Live Picture’s positioning tools facilitate the scaling and positioning of objects within a

composite. An object can be an image, a mask, a stencil, a path, a view, an entire layer,

or even multiple layers that have been grouped together. 

Positioning only applies to objects that have been selected (outlined in blue in the layer

stack). The positioning tools are:

Live Picture scales and positions objects in relation to two points; the X-Point and the

Positioning-Box. 

The X-Point is a reference that Live Picture uses for all scaling, rotating, skewing, flipping. 

The Positioning-Box is a boundary with small movable squares (handles) along its edges

that are used for all scaling, rotating, skewing and flipping. It automatically appears when

in the positioning mode. 
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Toggle between Creative Tool Bar and Positional Tool Bar

Scaling Tool: Scales the selected object and/or moves it around the X-Point

Rotational Tool: Rotates the selected object around the X-Point

Skew Tool: Skews the selected object around the X-Point 

Perspective Tool: Changes the selected object’s perspective

Cropping Rectangle: Crops the selected image by changing its Stencil

Positioning Box Tool: Moves the Positioning Box and the selected object

Zoom Tool: Enlarges or reduces the view

Pan Tool: Moves the entire composite around the work space

Vertical Flip Tool: Flips the selected object vertically around the X-Point

Horizontal Flip Tool: Flips the selected object horizontally around the X-Point
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Positioning Tools

The X-Point defines the only stationary point in an object as it is positioned. The X-point

can be placed anywhere within the composite, either by dragging or by co-ordinates. By

default the X-Point appears in the centre of the object. Only the cropping and Perspective

tools do not make use of the X-Point.

The Positioning-Box can be repositioned anywhere on the desktop by clicking and drag-

ging with any positioning tool. 

The Shift Key constrains movement to the horizontal, vertical or diagonal axis.

Option clicking and dragging the Positioning-Box Tool re inserts the selected image at any

scale anywhere on the desktop while undoing all previous perspective changes. With any

Positioning-Box Tool selected the image can also be nudged one pixel at a time using the

arrow keys.
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Layer Elements

Each layer includes three basic elements: The Source, Mask and Stencil.

Source             Mask             Stencil. 

It is the interaction of these three layer elements that determines the appearance of a

layer and defines its interaction with other layers.

The layer panel is used to manipulate layer elements. Each layer element also has a drop

down menu in the layer panel listing alternative options. Clicking once on any layer ele-

ment (icon) selects that element of the layer, so that it can be manipulated independent-

ly of any other layer elements. Shift clicking on more than one layer element (and even in

more than one layer panel) means all those selected layer elements can be manipulated

together but independently of the other non-selected layer elements.

The Source
There are four types of sources in Live Picture: Paint, Image, Effects and Colour. For

example the source of a Mono colour Layer is a single paint colour. The source of an Image

Layer is an IVUE image. An Effect Layer has a Sharpen and Blur source. The source of a

Colour Layer is a colour correction that applies to all underlying layers in the layer stack.
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Mono Colour

Multi Colour

Colorize

Image Insertion

Image Distortion

Sharpen/Blur

Colour Correction

Paint

Paint
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Image
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Normal

Hard Edge

Normal

Inverted

None
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Masks and Stencils

The Mask
The mask is the part of the layer that defines what you see of the source. In other words

the mask reveals the source. Image Layers are inserted with a default mask that defines

their opacity. All other layers remain transparent until you create a mask. Masks are cre-

ated and modified using Live Picture's creative tools, for example by brushing in or filling

the layer at a certain % opacity. The type of layer you are working in determines the type

of mask you create; image, paint, effects or colour correction. Each time you alter an

image you alter its mask. As the opacity of the mask increases, so does the visibility of its

source. Each point in a mask can have a different opacity. This allows you to blend

images with seamless precision. You can modify a mask at any time by activating (double

clicking) the layer containing the mask and modifying it by using the creative tools. For

example each time you brush in a layer you change its mask. You can also reposition

masks at any time by using the positioning tools.

The Stencil
A stencil is an outline that further defines the visible region of the source. A stencil is

made up of two parts: an opening, which is cut to your specifications, and a solid area.

The solid area blocks out the source it covers so that it doesn't appear in the composite.

The opening shows the source. Like masks, stencils are defined by their opacity and can

be repositioned at any time by using the positioning tools. A stencil doesn't change the

mask, it only reveals the mask in the same way that the mask reveals the source. However

unlike masks, stencils once created have their opacity fixed (until they are recreated).

Creating Masks and Stencils
You can create masks and stencils using a variety of methods. The most common method

for creating a mask is to use the creative tools or silhouetting tools. The most common

methods for creating a stencil is to use either the Crop tool (in the positioning tools) or

one of the Path tools, which can then have a variable-opacity (feathered) edge defined. You

can also create masks and stencils by copying (option-dragging ) them from existing layer

elements or from other layers. When you copy a mask (or stencil) from one layer to anoth-

er, the mask (or stencil) reveals the same area in the new layer. For example, the cropping

of an image (it’s stencil) can be copied to the stencil of a Colour Correction Layer, there-

by constraining the effects of the Colour Correction to the same cropping as in the image.
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Image Layers

Of Live Picture’s nine layer types, three are ‘image layers’ 

1.  Image Insertion Layers
2.  Image Distortion Layers 
3.  Image Silhouette Layers

The Image Insertion Layers and Silhouette Layers excel in the placement, selection and

insertion of image elements. The Image Distortion Layer excels in the unlimited and infi-

nitely  variable local distortion of an image. In all Layers, the Positional Tool Bar allows

the image elements in individual layers to be cropped, moved, rotated, flipped, skewed,

enlarged, reduced or in other ways alter their perspective.

Image Insertion Layers
• An Image Insertion Layer allows an image to be inserted at varying levels of opacity. 

• It can be locally inserted or erased by brushing in the image.

ª It can also be inserted with a rectangular Fill Marquee (including horizontal, vertical 

and four-point gradient fills).

Image Distortion Layers
• Any degree of local or all-over distortion can be obtained.

• The distortion can be equally employed to heighten the realistic portrayal or abstrac-

tion of the image.

• It can be used in compositing image elements together, such as in distorting one image

to fit into, onto or around another.

Image Silhouette Layers
• Silhouette Layers create Masks that describe the local opacity/density of the image 

layer. Being a mask, they can be infinitely modified or corrected.

• A Silhouette Layer can ‘select’ or ‘cut out’ image elements based on either their Colour

or Tonality (Luminosity).

• A Colour Compensation Silhouette selects by colour.

• A Luminance Silhouette selects by tone. 
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Manipulating Image Layers

• An Image Insertion Layer allows an image to be inserted at varying levels of opacity. 

• It can be inserted by locally brushing to what ever density/opacity is desired. 

• If required, only part of the image can be brushed in or erased. 

• The image can also be globally or partially inserted with a rectangular Fill Marquee 

(including horizontal, vertical and four-point gradient fills).

• All adjustments in an Image Insertion Layer can be undone or redone to any extent at

any time.

• The % opacity settings for the Brush, Eraser and Marquee tools in the Tool Bar repre-

sent the maximum opacity obtainable (not the rate of application) at that setting.

• All tools are Pressure Sensitive. The Rate of Application can be further controlled by 

adjusting the Pressure Control slider in the Tool Bar. The keyboard keys 1 = 10% to 

0 = 100% also control the pressure level of the stylus.

• The Image Insertion tools create a variable density/opacity Mask of the inserted image. 

• A section of the image can be outlined with the Path Tool. 

• The path can then be converted to either a Mask or a Stencil. 

• The edge of the Stencil or Mask can be as hard edged or soft edged/diffuse as desired.

• A Mask Icon or Stencil Icon in the Title Bar of a Layer can be selected (clicked once so

it is highlighted in red) and Option-Dragged to another Mask or Stencil Icon in any 

layer, thereby transferring that mask or stencil information to another layer.

• A Stencil can be inverted or turned off altogether by selecting the required option from

the drop down sub menu of the Stencil icon in the Title bar of any Layer.
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Blending Images

1. Using Image Insertion Layers, images can be inserted both globally and locally to what

ever degree (of opacity) is required. Remember an opacity setting (%) in Live Picture 

represents the maximum level of opacity that can be achieved, rather than its rate of 

application as in Photoshop.

2. Usually the Inserted Image is placed above the original image (or background image) 

and inserted by brushing it in at varying opacity. Less than 100% means less than 

100% of the (top) image is visible hence the lower image becomes inversely visible. For

example if the top image is inserted at 0% opacity then the lower image becomes 100%

visible.

3. Rather than brushing the image in, a variable % Gradient Fill can be globally applied

to the inserted image (or section of the image). This renders the inserted image (or cho-

sen section) at varying opacity which also inversely reveals the underlying image. The

Brush Tool can then be applied at varying opacity to  locally reveal (re-insert) or fur-

ther remove the inserted image. Oscillating between the Brush and Eraser Tools 

(pressing the Command Key will change the Brush into the Eraser) will enable the top

image to be inserted with great precision.

4. If the image is inserted with the Auto Insertion Box unchecked in the Image Insertion

Dialogue Window, the image will be inserted with the Positional Tool Bar active, and 

the overall opacity of the inserted image can then be controlled by the Opacity Slider

at the bottom of the Positional Tool Bar. This overall Opacity Slider is only available in

the Positional Tool Bar the first time the image is inserted. This is helpful when trying

to line-up and scale two images relative to each other. Inserting the second image at 

30% to 50% will allow both images to be viewed at the same time, and their relative 

placement, scale and shape to be adjusted as required.  Once their relative positions

are correct, they can then be locally re-inserted (with Brush, Eraser and/or Gradient

Fill) at their final opacity.

5. Especially detailed work can be achieved with the Eraser Tool at 100% rather than the

Brush Tool at 0%. This is because the second set of smaller brushes (the Micro 

Brushes) are only available with the Eraser Tool or Brush Tool at 100% opacity. Hence

erasing the image works just as well as brushing in the image at 0% opacity. 
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Blending Image Layers

Initially insert the image then erase those parts not required. Note that the Micro Brushes

also have a harder edged profile compared with the larger softer edged brushes. 

6. Remarkable control of an image's local character can be achieved by blending togeth-

er different renderings of that same image (in terms of colour or contrast or density). Auto

insert the same image on different layers, then colour and/or density correct each layer

before blending (locally inserting) them as required. Alternatively ‘Option Click and Drag’

the original image to a new position in the layer stack to duplicate it with perfect regis-

tration. This is helpful if you have initially had to use the Positional Tool Bar to modify

the image's  position or dimensions. 

Variable Contrast Printing
Blending together a high contrast and low contrast version of the same image. 

• Duplicate the original image. 

• Click once on the top version of the image to select it (to highlight it in blue) and then

use the Layer/IVUE Correction/Curves to lower its overall contrast. 

• Repeat for the other version of the image, but increase its contrast. 

• Locally blend the two images together as required. 

For example, a landscape image might benefit from variable contrast printing where the

contrast of the sky is lowered while the contrast of the land is increased, by variably

blending high and low contrast versions of the same image.

The same principle can be applied to create variable local shifts in density, colour and/or

saturation in the image. In each case use the Layer/IVUE Correction/"Tools" to change

the overall character of each duplicated version of the image, then locally blend the dif-

ferent versions together as required. 

For example, the subtle blending of warm tone and cold tone versions of the same por-

trait can introduce an alternative psychological reading, or different sides of a face can

project a different emotion. Blending warm and cold tone versions of an architectural

image or a landscape can significantly change its spatial and psychological rendering. 

The same image photographed at different times of the day can also be blended together.
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Editing Tools

There are 5 additional tools of particular use to artists and photographers. 

The first two tools are found in the Menu Bar/Layer/ menu:

1.  IVUE Correction/Levels (Global Colour Balance}

2.  IVUE Correction/Curves (Global Tonal & Colour Control)

Both of these IVUE Correction tools act globally across the entire IVUE image. The effects

can also be locally applied to the image through specific curve adjustments or variable

insertion in image insertion layers.

The next three tools are found in the Menu Bar/Create/ menu:

3. Colorize Layers (Reduction and Intensification)

4. Colour Correction Layers (Tone & Colour Control)

5. Sharpen/Blur Layers (Spatial Relations)

These tools produce changes that are applied locally with a brush or globally with the

marquee tool at varying levels of opacity. They are Live Picture’s most ‘photographic tools’

in their effect and feel. Combined with variable image opacity (insertion) they provide a

remarkable range of controls for the photographer. 

It is important to realise that Live Picture allows any effect to be applied to any degree,

anywhere in the image. Most corrections or modifications are made locally with the Brush

Tool. The Brushes are pressure sensitive tools that allow incredibly subtle and flexible

execution particularly when used with a pressure sensitive stylus and tablet. 

Don’t forget, an image can be variably inserted (by brush or marquee) to any level of opac-

ity. In this way two or more versions of the same image (lighter or darker, softer or hard-

er, cooler or warmer, etc) can be effortlessly blended together. For example, a lighter lower

contrast version and a darker higher contrast version of the same image can be variably

blended together giving the photographer complete local control over density and contrast

in colour and black & white images.
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Colorize Layers

Colorize Layers can be used to alter the hue of an image, and intensify and/or reduce an

image, locally or all over. Colorize Layers use the paint brush (or marquee or gradient) in

three basic modes: 

Paint          Lighten          Darken

Lighten increases the highlight contrast. This digital effect is similar to using a subtrac-

tive chemical reducer on a silver gelatin print.

Darken increases the shadow contrast. This digital effect is similar to using a Chromium

Intensifier on a silver gelatin print.

Paint colorizes (colours) the image with the hue selected in the colour picker.

• Neutral colours (white/grey/black) increase image contrast without changing the hue. 

• Painting with white and black produces the same result as Lighten and Darken.

Colorize Layers can also both reduce (Lighten) and intensify (Darken) an image at the

same time. This change in contrast can also be pivoted around any desired part of the

tonal scale. For example by Painting with 50% grey an image will be equally reduced

(Lightened) above middle grey while simultaneously being equally intensified (Darkened)

below middle grey. However there is a ‘trick’ to applying this remarkable effect. 

Use the eye dropper to select the ‘Pivot Value’ in the image. Note this Value (%) then drag

the eye dropper along the colour palette’s neutral grey scale until the inverse Value (%) is

obtained. For example if the desired pivot Value is 20% (Zone II), the actual Value %

should be set to 80% (100 – 20). Use the brush or marquee in the Paint mode to then

reduce (Lighten) all values above 20%, and intensify (Darken) all values below 20%. The

contrast changes will be either side of the Pivot Value of 20% while it remains unchanged.

The gradient tool can also be used to create complex reduction and intensification (con-

trast) transitions. Use the eye dropper to select the Pivot Value, then choose its inverse

value from the colour picker’s grey scale and set it in the colour picker. This procedure

will need to be repeated to set each point in a complex gradient.

If the selected hue is almost but not exactly neutral (for example 127R 127G 132B) the

reduction and intensification will take on a slight (blue) hue. This is a wonderful way to

gently tone (colour) the print while increasing its contrast. 
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Color Correction Layers

Almost any effect can be created via a Colour Correction layer. A selected input value is

modified and then locally and/or globally applied to the image at varying opacity. 

Example 1:

An image has a localised green colour cast. Sample this area with the input colour eye-

dropper (drag from the input colour swatch) and define its input hue and/or saturation

and/or brightness range. Choose Shift CMYK as the output mode  and adjust the magen-

ta (minus green) output values to darken and colour correct the cast, or choose Shift RGB

and adjust the green output values to lighten and colour correct the cast. The locally

brush in these corrections at varying levels of opacity to correct the image.

Example 2:

An image is colour balanced but lacks luminosity. Add a colour correction layer and sam-

ple the mid tones with the input colour eye dropper, defining only its input Brightness

range, say approximately zone IV to VI. Choose Shift HSV as the output mode and

increase brightness by 10%. This will automatically raise all tones in the selected input

range one zone. Then locally (or globally) paint this effect into the image.

All sliders are interactive with the results clearer visible in the before an after dialogues.
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Working with Layers

Split Toning

1. Open a Colour Correction Layer.

2. Use the Eye Dropper from the ‘HSV Select’ colour selection box to select the zone to be
toned (coloured). 

3. Adjust the “V” (brightness) tolerance sliders around the selected zone to encompass as
wide or narrow a range of tones as required.

4. Use the ‘RGB Shift’ sliders (in the After Box) to produce subtle colouration shifts. 

5. Then use a global fill to insert these values into the image at the required intensity. 
This can also be modified locally with a brush.

6. Repeat this procedure with another one or two Colour Correction Layers for other parts
of the tonal scale (for example one layer for the shadows (II to IV), one for the mid-tones
(VI to VI) and another for the highlights (VII to VIII). 

7. When this is done subtly the results are magnificent. Certainly much better than what
can be achieved with curves. The colours are cleaner and better separated and are 
more easily controlled. There is no direct equivalent to this technique in Photoshop.
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Balancing a Photographic Image

1. Open a retouched and uncompressed 8 bit per channel TIFF file in Live Picture’s 

Menu Bar/Converter Menu and then Save As in the IVUE File Format.

2. Create a NEW workspace from the Menu Bar/Create Menu.

3. Create an Image Insertion Layer (Cmd 4) from the Menu Bar/Create Menu with 

the IVUE file you wish to work on. 

4. Adjust the white (highlight) and black (shadow) sliders in Menu Bar/Layer/IVUE 

Correction/Levels for each RGB channel to correct the density of the image. 

5. Adjust the Gamma slider in Menu Bar/Layer/IVUE Correction/Levels for one or 

more channels to modify the image’s overall colour balance as required.

6. Add Colour Correction Layers (Cmd 9) from Menu Bar/Create Menu to further con-

trol the hue, contrast and saturation. Use a marquee to globally apply the changes or

locally brush in the changes to any level of opacity as required. Use any number of 

Colour Correction Layers to adjust any number of different image elements.

7. Add Colorize Layers (Cmd 3) from Menu Bar/Create Menu to intensify and/or reduce

the image to locally tension the tonal and colour composition.

8. Add Sharpen (& Blur) Layers (Cmd 8) from Menu Bar/Create Menu to control local 

spatial relationships within the image. Subtle sharpening in single RGB layers can 

have a very significant effect on the “colour luminosity” of the image.

9. Variably Insert duplicate layers of the same image into one another to further blend 

local variations in contrast, hue, saturation, and density. 

10. Save the changes as a FITS file. The same FITS file can be used to File/Build out dif-

ferent print sizes/resolutions of the same image with minimal loss of quality. Different

Views can also be created to build out different cropped versions of the same FITS file.

Build with Anti Aliasing if the images are at resolutions greater than 100%.
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Silhouette Layers

• Silhouette Layers create Masks that describe the local opacity/density of the image 

in that layer. 

• A Silhouette Layer renders image Masks according to the precision of the photo-

graphic image itself. 

• This makes a Silhouette Layer an extremely powerful tool for the critical selection of 

image elements to be included in composite images.

• A Silhouette Layer ‘selects’ image elements based on either their Colour or Tonality.

• A Colour Compensation Mask most accurately selects coloured image elements.

• A Luminance Mask most accurately selects image elements based on their tone. 

• Once silhouetted the layer becomes a normal Image Insertion Layer. 

• Silhouette Layers are often used when the local insertion of an image is either too com-

plex, too difficult, or too time consuming to accomplish with the Brushes, Eraser and

Marquee tool in an Image Insertion Layer.

• Silhouette Layers can be retouched or redone to any extent required. 

• Silhouetted Images can be built out (using their Mask as an Alpha Channel) and then

reinserted into another Image Silhouette Layer to further refine the selection or blend-

ing of individual image elements. 

• The selected Mask Icon in the Title Bar of a Colour Compensation Mask or 

Luminance Mask Layer can be selected (clicked once to highlight in red) and then 

Option-Dragged onto the Stencil Icon of any other Layer. 

• This will then allow that Layer to be variably inserted only within the boundary of the

Stencil. 
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Luminance Masks

A Luminance Mask will isolate selected areas of the image based on their selected tonal

values so that they can be individually controlled and/or composited. In the Preview Mode

the luminance histogram graphically represents the distribution of pixels in the image

according to their tonal values. The histogram’s Black Slider represents the Black Point

in the Mask, and the White Slider represents the White Point in the Mask. The Black and

White Points can be set anywhere within the Histogram.

In the resulting Luminance Mask everything between the Black Point and its end of the

Histogram is not visible in the Mask, while everything between the White Point and its end

of the Histogram is visible in the Luminance Mask.

The distance between the Black and White Points represents the transition in the

Luminance Mask between what is not visible and what is visible. The further apart the

Black and White Points are, the more gradual the transition between what is visible and

invisible in the Mask.

The White Slider can also be placed on top of the Black slider creating an instant transi-

tion between what is visible and not visible in the mask. Usually some degree of transi-

tion is desirable to allow the masked areas to be ‘seamlessly’ incorporated back into a

composite without looking as if they have been ‘cut out’.

The White and Black Points can also be set numerically. The 256 levels between Black (0)

and White (255) can be represented as a Zone System of ten equal zones approximately

25 levels apart.This makes settings for the White and Black Points very easy to calculate.

For example Zone III = 75 levels (3 X 25), Zone VII = 175 levels (7 X 25) etc. Use the colour

picker to locate precise the tonal values in the image that need to be masked out.
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Color Compensating Masks

A Silhouette Layer Mask will be based on the colour differences in the image when the

Colour Compensation Mask mode is chosen in the Silhouette Layer dialogue box.

Select the Brush Tool (and the Auto setting from its sub menu) with a Silhouette

Tolerance on the menu bar of around 40%. To select an area as ‘outside’ or ‘inside’ first

select (click on) the appropriate box in the menu bar. The selected box is outlined in red.

Click and drag (over the values to be included in the mask. Holding down the shift key

will add values to those already selected. Choose which half of the mask (inside or out-

side) to first select according to which area has the more uniform colour range. Change

the tolerance settings if required and keep auto-choosing until the inside (or outside) area

is relatively complete. The opposite half (outside or inside) of the mask can then be easi-

ly selected by dragging a 100% Gradient Fill over the image.

Create the silhouette by clicking on the Compute button (Scissors Icon on the Menu Bar).

Initially apply the default settings in the dialogue window (i.e.. a Colour Compensating

Mask with a tolerance setting of 20 pixels gives a very realistic edge transition). 

Use the Eraser tool with the remove setting to retouch (‘clean up’) both the inside and out-

side silhouette areas. Make sure the correct colour box on the menu bar is selected (out-

lined in red) before trying to retouch that area.

Complex edge transitions can be handled by using a Brush at the Selective Setting (from

the Brush sub menu). Drag the brush around the desired silhouette-boundary varying

tolerance levels (and/or by Option Clicking to select the inside/outside values) as

required. Then use the Auto Brush to complete the silhouette.

Alternatively use the Silhouette Layer to compute a mask that is further  refined at a high-

er level of magnification with the Brush Tool. i.e.. Once the mask has been computed the

Image Silhouette Layer becomes an ordinary Image Insertion Layer. Option Clicking in the

image with the Brush Tool's Outline Option (chosen from the Brush sub menu), auto-

matically creates or refines the silhouette based on locally selected (Option Clicked)

inside/outside colours. 
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Path Tools

Live Picture’s Path Tools are made up of:

Live Picture 2.5.1 Live Picture 2.6.2

1. The Path Tools allow you to hand draw a path within an image. 

2. The path may or may not follow the contours of the image. 

3. The Path Tools provide an alternative masking method to a variable Image Insertion 

Layer or a Silhouette Layer. 

4. Paths can be individually selected, all selected or hidden, inverted, brushed along/out-

lined, continually modified, grouped together, and converted to Masks or Stencils.

5. Paths can be converted to Stencils in all layers. 

6. Paths can be converted to Masks in all layers in version 2.6.2, but only in Mono colour, 

Artwork, Image Insertion and Colour Correction layers in version 2.5.1.

7. Some of the additional path tools in version 2.6.2 can be duplicated with short cuts in 

version 2.5.1. For example option clicking on a path with the 2.5.1 Scissors Tool adds 

a new anchor point, and control clicking on an anchor point with the 2.5.1 

Selection Tool, turns it into a corner point.

8. The key to making usable paths is to make a closed path by re-clicking on the first 

anchor point to complete the path. 
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Selection Tool
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Scissors Tool
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Creating Paths

• Paths can be created by clicking individual anchor points around a perimeter.

• Clicking and dragging with the Pen Tool will automatically drag out a direction line 
through the anchor point and turn it into a corner point. Each end of the direction line
is terminated with a direction point.

• A direction point allows the length of the direction line to be altered, and for the direct-
ion lines to be moved. Clicking on a direction point and dragging out its direction line
modifies the shape (curve) of the path.

• Use the Corner Tool to click on an anchor point to toggle it between a corner point 
(directional anchor point) and an anchor point.

• Click the Selection Tool on an anchor point to activate it (and any directional points).
Active anchor points can be modified. Shift clicking will activate additional anchor 
points and allow them to be all modified together.

• Use the Selection Tool to click (activate) and drag an anchor point or direction point.

• Activating an anchor point by clicking on it with the Selection Tool then pressing the 
Delete Key will remove the anchor point and the line segments immediately above and 
below it from the path. 

• Alternatively use the Plus and Minus Pen Tools in 2.6.2 to add or remove anchor 
points and hence modify the path.

• On the other hand the Scissors Tool removes anchor points but leaves the original 
path without modification.

• With the Selection Tool drag out a rectangle crossing over a path to select it (make it 
active). The rectangle doesn't have to contain the whole path to select/activate all of 
the path. 

• The Freehand Tool allows you to draw freely around an object while automatically 
inserting the anchor points for you.

• The Text Tool inserts text into a layer as a complex path that can then be converted to
a mask or a stencil (Mask/Path --> Stencil or Path -->Mask) as required.

• The Oval and Rectangle Tools allow you to easily create Oval and Rectangle paths. 
Holding down the Shift Key will constrain them to Circles and Squares.

• The Magic Marker Tool (LP 2.6) automatically creates a path around selected edges.
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Path Shortcuts

• Selecting anchor points with the Selection Tool allows those selected points to be 
moved. Selecting all anchor points in a path allows the entire path to be moved.

• Option dragging a selected path with the Selection Tool duplicates the path.

• With either of the three pen tools (normal, add, subtract) holding down the Command
Key will turn them into the selection tool.

• Command Key/Pen Tool clicking on a direction point will toggle it between a linked or
independent direction point.

• Control clicking on a direction point will also toggle it between a linked or independ-
ent direction point.

• Holding down the Command and Control Keys will turn a pen tool into the corner tool.

• Alternatively Control clicking with the Selection Tool on an anchor point will toggle it
between a corner point and an anchor point. 
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Edge Burning

1. Duplicate the original Image Insertion Layer by first selecting the layer (click once to
put a blue outline around the layer) and then Option Drag the layer to duplicate it in
the Layer Palette. Rename the original image layer (eg. ‘Stencil’) to distinguish it from
the lower duplicate image layer.

2. Click once on the on the ‘Stencil’ layer to active it (signified by a blue outline) and 
choose the Oval Path Tool from the Paths menu in the Creative Tool Palette.

3. Draw out an oval path. (Holding down the Shift Key constrains the path to a circle).

4. Choose the Selection Tool from the Paths menu (or hold down the Command Key with
the Oval Tool) and click on one of the path Anchor Points and drag it to an appropri-
ate centred location within the image.

5. From the Mask menu on the Menu Bar choose Path to Stencil.

6. Set the Feathering somewhere between Medium and High as appropriate.

8. This removes the outer area of the ‘Stencil’ image layer.

9. Click once on the lower duplicated Image Layer to select it (signified by a blue outline
in the Layer Palette) and use the Gamma Slider in Layer/IVUE Correction/Levels to 
darken this lower image layer as required.

10. Click the preview box in Layer/IVUE Correction/Levels to be able to judge the 
required degree of the edge burning in the composite image. Click OK to accept the 
changes. This produces the desired degree of edge burning.

11. A Colour Correction Layer can also be used to lower the edge contrast and thereby 
further increase the central image luminosity. This effect is similar to local pre-expo-
sure in analogue printing. Create a Colour Correction Layer between the two image 
layers, immediately above the lower duplicate Image Layer. Select the highlights in the
Colour Correction Layer and reduce their tonality (V) by 10%. Apply this Colour 
Correction effect with a global fill up to 100%. 

12. Alternatively edge gradients (or four quadrant gradients) can be created in a Colorize
or Colour Correction Layer. For example graduating from 10% to 0% will create a 10%
‘edge burn’ across the width of the gradient. In this way variable colour gradients can
also be used to create colour corrected edge burning.
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Compositing with Alpha Channels

Compositing in Live Picture

In a Live Picture document individual Image Layers can be used to composite any image

element or object into a final image. 

Image elements can be:

• Locally and variably inserted (brushed in) into any Layer.

• Automatically selected (cut out) in Image Silhouette Layers based on either:

• Tonal differences (Luminance Masks) or 

• Colour differences (Colour Compensating Masks).

• Cut out of any Layer using the Path Tools and then converted into a Stencil or a Mask.

Alpha Channels

In Photoshop, masks (and selections)  are stored as alpha channels. In Live Picture every

layer is defined by a mask and a stencil. Therefore Alpha Channels in Live Picture have a

special meaning that describe something different to either a mask or a stencil. Their

effects however are similar to alpha channels in Photoshop.

Alpha channels also provide another powerful feature in Live Picture that enable locally

selected objects to be built out as a new IVUE image without any background showing.

This means that JUST the object that has been masked or stencilled out of its original

background can be built out as an IVUE image to be inserted into another document.

This use of Alpha Channels allows the incorporation of the effects of more than one Image

Layer (Image Insertion or Distortion or Silhouette) in another Image Layer (Image

Insertion or Distortion or Silhouette). This is particularly helpful in a creating complex

composite images.
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Compositing with Alpha Channels

An  example of complex composites is where the selected object(s) is a complex shape and

the usual variable brush insertion technique in an Image Layer is not accurate enough,

or is too time consuming or difficult to do. You then might choose to use an Image

Silhouette Layer to quickly and automatically select the object. However if you also want

to distort this selected object you only have the Positional Tools to do this in the Image

Silhouette Layer. They are helpful but can only to change the relative scale and perspec-

tive of the object. They can’t for example do any local freehand distortion in the Image

Silhouette Layer. This facility is only available in an Image Distortion Layer. 

The problem is that if you build the Image Silhouette Layer as a new IVUE image (to then

reinsert as an Image Distortion Layer) you have to build from a view. You always build

from a view. Views are also rectangular and always include the Background Layer in the

Layer Stack (because the Background Layer can’t be turned off). A beautifully silhouetted

object would be built out as well as the Background Layer, hence when it is reinserted in

an Image Distortion Layer, the Background Layer would also be visible. 

What is required is to be able to build without including the Background Layer, so that

only the selected image objects are included in the new IVUE image. The solution is to use

the Image Layer containing the selected object(s) as an Alpha Channel. This is very easy

to do. 

Including Alpha Channels in a Layer

Any type of layer can be used as an Alpha Channel. Mono colour Layers, Image Layers,

Colour Correction Layers etc can all be used as Alpha Channels. Select the Layer you

want to use (click once on the Layer in the Layer Stack so that it is outlined in blue =

selected) then choose Mask/Use as an Alpha Channel from the Mask submenu on the

Menu bar. 

Note that this shades the selected layer in 50% red in the Layer Stack, indicating that this

Layer is now being used as an Alpha Channel. 

It is important to understand that when you define a Layer as an Alpha Channel, you are

turning whatever is VISIBLE ON THE SCREEN FOR THAT LAYER (including the effects of

that Layer’s Stencil and Mask) into an Alpha Channel. Therefore what is made visible by

the Stencil and Mask is all that will be built out as a new IVUE image.
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Compositing with Alpha Channels

Building the Alpha Channel as a New IVUE Image

When you build a Layer that includes an Alpha Channel as a new IVUE image (incorpo-

rating the Alpha Channel) you must remember to check the Include Alpha Channel box

in the Build Dialogue. Also notice in the Save Dialogue that requests the name and des-

tination for this new IVUE image file, that the Include Alpha Channel box is automatical-

ly checked.  Apart from this the build process is no different to a normal build. 

Inserting an IVUE Image with an Alpha Channel

Any image that includes an Alpha Channel can be inserted into any Image Layer. 

When you insert an IVUE image containing an Alpha Channel, the preview in both the

Preview Image in the Layer Stack and the Open Dialogue highlight the missing back-

ground in bright red. The outer boundary of this red area is defined by the rectangular

dimensions of the view that was used for the image build. 

An Example Illustrating this use of an Alphe Channel

Problem: How can an image be distorted so that it appears to conform to the contours of

another image? For example to bend text so that it appears to wrap around the surface

of another object? 

Such manipulation of individual image elements is very easy to control in Live Picture.

Complex composites usually require the task to be broken down into several steps, and

this may involve one or more intermediate builds.

The wrapping of cut out text around the surface of another object is a simple illustration

of this process. It requires three stages, with intermediate builds of new IVUE image files

at the end of the first and second stages. 
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Working with Alpha Channels

Stage One

1. CREATE a mono colour layer.

2. FILL a rectangular area with colour.

3. Use the TYPE TOOL to create the required text.

4. CONVERT the text Path to a hard edge stencil (Mask/Path Æ Stencil).

5. BUILD out the image to the desired size and resolution as an IVUE file.

Stage Two

1. CREATE a new document.

2. INSERT the 'text' IVUE file into a Silhouette Layer.

3. Choose the text as the INSIDE AREA. Fill the rest of the image as the OUTSIDE AREA.

4. COMPUTE the layer as a Colour Compensation Mask with a hard edge. (This will cut

the image out of its background).

5. Change this Mask to a ALPHA CHANNEL by using the Mask/Use as Alpha Channel 

command. (Note that this layer will now be shaded in 50% red in the Layer Stack, iden-

tifying it as an Alpha Channel).

6. BUILD this image out as an IVUE file. In the Build Dialogue make sure you check the

Include Alpha Channel box. 

7. SAVE this file Including the Alpha Channel.

Stage Three

1. CREATE a new document.

2. INSERT the text image containing the Alpha Channel as a Distortion Layer.

3. INSERT the image of the object or surface that you want to wrap the text around. 

Position this image insertion layer below the alpha channel text layer. 

4. ACTIVATE the Distortion Layer and use the paint brush to locally distort (and insert)

the image as required, wrapping it around the object.

Copyright Les Walkling 2005 38/46



Live Picture Workshop 
Paths and Alpha Channel Masking 

Importing Images with Alpha Channels

An Alpha Channel is a pixel based mask. 

An image containing an Alpha Channel created in another program (such as Photoshop)
can be used in Live Picture. The image can be imported into any of the three Image Layers.
(Image Insertion Layer, Image Distortion Layer, or Image Silhouette Layer). 

In Image Insertion and Distortion Layers the Alpha Channel acts as another stencil
through which the image is displayed. In an Image Silhouette Layer the Alpha Channel
(pixel based mask) can also be converted into a resolution independent mask, which in
turn can be converted into a path, or a stencil. 

1. First convert the image to the IVUE file format. In the Save As dialogue make sure to
check the Include Alpha Channel box. (This box will be ghosted if the original image 
doesn’t contain an alpha channel).

2. Insert the image in an image layer. In the Open Image dialogue make sure the Use 
Alpha Channel box is checked. (The alpha channel then appears red in the preview 
area of the Layer Stack). 

3. When an image is inserted in an image layer, it is displayed through its alpha chan-
nel. The alpha channel can be turned off or on by clicking on the Source Icon and 
dragging between its Image and Alpha Channel icons. (The Source Icon is the first icon
of the four icons along the top of each layer bar in the layer stack. The icons from left
to right are: Source Icon, Mask Icon, Stencil Icon, & Visibility Icon). 

4. In Image Insertion and Image Distortion Layers any modifications brushed into the 
image are displayed through the alpha channel. The alpha channel acts as another 
stencil.

5. In a Silhouette Layer, insert the image then click the Scissors Icon (on the Active Layer
Menu Bar) to bring up the Compute Mask Options dialogue. In the Computing Mode 
box select Alpha Channel (rather than Standard, Colour Compensating, or Luminance
modes).

6. Click the Compute Button to bring up a Mask Setting histogram, set the white and 
black points, then click OK. (This works the same way as with a Luminance Mask. Any
value between the white (highlight) point and the end of the histogram will be visible,
while anything between the black (shadow) point and the other end of the histogram 
will be invisible. The distance between the white and back points represents the tran-
sition between what will be visible and invisible). 

7. Compute the silhouette to turn the Alpha Channel into a resolution independent 
mask. This can then be converted into a path, which can also be converted back into
a mask or a stencil.
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Working with ICC Profiles

Live Picture uses Apple ColorSync to manage colour and consists of two procedures: 

• Assigning Reference, Monitor and Output Profiles

• Soft proofing the Monitor and/or Output Profiles.

Assigning an RGB Reference Profile

The Live Picture Menu Bar/Edit/Preferences/ColorSync dialogue allows a Reference
(Source) profile and  Monitor (Destination) and Output (Destination) profiles, to be select-
ed. These preferences will over ride the ‘system settings’ in the Apple ColorSync control
panel (if they are different). 

The Reference profile represents the colour gamut that the image (colour numbers) will
be mapped into, and the gamut in which the image is edited, saved and archived. If the
colour gamut of an image is unknown, different Reference profiles can be selected (in
ColorSync Preferences) and soft proofed via Menu Bar/View/Display Matching, until the
best screen rendering is obtained.

Live Picture will allow a scanner or digital camera profile to be used as the Reference pro-
file, so that an image only needs to be converted once from a capture gamut to an output
gamut. This will further minimise the possibility of image degradation at the output stage.
Live Picture can output to any profile. However Live Picture does not embed or read
embedded profiles, so images must be manually colour managed in any creative workflow.
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Proofing

Enabling ColorSync in Live Picture’s ColorSync Preferences enables Live Picture’s soft
proofing facility. There are three soft proofing options available under the View Menu.

Display Matching             Soft Proofing             Gamut Warning

Display Matching
This setting converts the image from the Reference (Source) profile to the Monitor
(Destination) profile, thereby accurately representing the image on the monitor. However
Display Matching is only as accurate as the accuracy of the monitor calibration & profile. 

Soft Proofing
This setting first converts the image from the Reference (Source) profile to the Output
profile of the printer, and then to the Monitor profile, in order to accurately display the
image as a virtual print (soft proof) on the monitor. However unless the monitor calibra-
tion & profile accurately reproduces the colour (white point) and brightness of the print-
ing paper, it will not be an accurate soft proof. The viewing conditions around the moni-
tor, including the colour scheme, and the brightness, colour temperature and colour spec-
trum of the viewing light, will also effect the accuracy of the soft proof.

Gamut Warning
This setting will overlay on the screen a uniform colour/tone (50% red by default) identi-
fying those colours (if any) in the Reference gamut that are outside of the Output gamut. 
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The ColorSync Workflow

A typical ColorSync managed digital photography workflow might look like this:

What Live Picture Doesn’t do

Live Picture does not ‘see’ embedded profiles in image files, nor does it embed profiles in

IVUE files or in images built out from Live Picture. FITS files also do not save Live

Picture’s ColorSync Preference settings. Therefore this information has to be consciously

included in any Live Picture workflow. 

Live Picture also does not provide the facility to select rendering intents in soft proofing

or in the build menu. Instead Live Picture applies the profile’s default Perceptual render-

ing intent (which is embedded in the profile during its creation). Special profile viewing

software such as ColorThink (www.chromix.com) is required to read and change the pro-

file’s default intent. However Live Picture will always apply a Perceptual rendering intent.

However this does not effect Live Picture’s ability to accurately colour manage images, it

just means that colour has to be manually managed in any Live Picture workflow.
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SCANNING:
Either scan directly  into   
Photoshop and your RGB 
Working Space, OR Batch  
process scans from your 
Scanner Profile to your 
RGB Working Space.

SPOTTING:
Apply the Dust and 
Scratches filter to a dupli- 
cate layer with darken 
and/or lighten blending.

CONVERT TO IVUE:
Either Export to IVUE
from Photoshop, OR
Open and Save As an  
IVUE file in Live Picture.

EDIT:
Edit & Soft Proof  the 
image in Live Picture, 
with Levels, Curves and  
Colorize, Sharpen and 
Colour Correction Layers.

EXPORT:
Build out from Live Picture 
as a TIFF file at the required 
size & resolution.

OUTPUT:
Convert in Photoshop 
from the RGB Working 
Space to the (Output) 
Printer Profile, and 
send to the printer.

DIGITAL CAMERA:
Import and Batch process 
files in Photoshop from 
your Camera Profile to 
your RGB Working Space.
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Creating New Images

Saving a FITS file only saves an instruction set describing the edits applied to the

image(s).  The original(s) remain unchanged and no new image is saved. However the FITS

file can also be used to Build (render out) a new file. Image builds are always constrained

to a specific View. If there is no View saved in a FITS file, no build can take place.

Numerous builds of different file sizes from numerous views are possible from the one

FITS file. The Build dialogue is located in the File menu.

To Build a new image from Live Picture

1. Select the View to build from and set Dimensions and/or Scaling and Resolution.

2. If required select Colour Matching and Emulate (locally) an off-site Output (printer).

3. Select Anti-Aliasing and/or Noise as required and File Format and Colour Model.

In practice the best image quality results from down sampling large original IVUE files.

Live Picture resizes images with nearest neighbour interpolation, or when Anti-Aliasing is

selected, bilinear interpolation. If the FITS file combines images with different resolutions

and/or scaling, use Anti-Aliasing to ‘reduce’ these differences. A small amount of noise is

always added to a build even when set to 0%. This contributes to the smooth gradients

that characterise Live Picture. Multiple builds can also be Batch processed. In general

build without Color Matching and then Assign the correct working space in Photoshop.
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Bibliography

Karson, Josh (1996)  Live Picture Revealed, Hayden Books, Indiana

(Out of print but usually available second hand from http://www.amazon.com)

_______ (1997)  An Introduction to Live Picture - The Student Guide, Live Picture Inc.

_______ (1997)  Live Picture Coming Up to Speed, A 90 Minute Training Video

(These last two items are very difficult to find)

Discussion Group

The Live Picture Discussion Group archive is at:

http://mail.idnet.net.uk:81/lpgroup/   (viewed February 2005)

In particular read everything by Joseph Holmes, Albert Edgar and Grant Symons.

Live Picture Discussion Group Instructions:

http://www.calverley.co.uk/LP-GROUP/   (viewed February 2005)

Purchasing Live Picture

Sealed copies of Live Picture 2.6 regularly appear on eBay. 

http://www.ebay.com/

As of February 2005, Live Picture remains very stable in Classic under Mac OS 10.3.7

Software Updates

Live Picture Software Updates:

http://www.calverley.co.uk/LP-GROUP/downloads.html   (viewed February 2005)

The preferred versions of Live Picture are 2.5.1 (fastest) and 2.6.2 (most features).
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